
*Revised 04/07/2021 

 

TELEWORK NEW HIRE INFORMATION 

 

I started working at NAVSUP WSS (Mechanicsburg) in late March 2020, towards the beginning of 

the COVID-19 pandemic. I was the “guinea pig” max-telework hire, and it was a lengthy process to get 

me up and running from home. My supervisor, team lead, and coworkers were incredibly patient and 

helpful during this process.  In order to aid future telework new hires, I compiled all of the helpful 

information I have gathered in my time thus far at NAVSUP. The information presented below is not 

exhaustive, but my hope is that it will smooth the telework onboarding/acclimation process. 

Do not hesitate to contact me if you have any questions, if you think of any helpful additions to the 

document, or if you find incorrect information that needs revision: daniel.diethrich@navy.mil. This 

document will be updated quarterly. 

-Daniel Diethrich 

 

A few notes to start: 

- All files highlighted in yellow are in the Confluence N6 Homepage. Files are Located at:  

- https://wiki.navsup.navy.mil/display/N6C/NAVSUP+WSS+N6+Home [NAVSUP WSS N6 

Home Page > Site Map > N6 File > TELEWORK New Hire Files] 

The files are also located on the shared J: drive at J:\$N61share\NewEmployeeInfo\Files 

- This guide is primarily for employees in N61 Mechanicsburg, and there will be some differences 

for new employees from a different code/site. If you are not in N61 Mechanicsburg, feel free to 

use this guide, but ask your supervisor for clarification on information that appears to be 

code/site specific. 

 

  

mailto:daniel.diethrich@navy.mil
https://wiki.navsup.navy.mil/display/N6C/NAVSUP+WSS+N6+Home
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BEFORE YOUR LAPTOP / VPN IS SET UP: 

There is not much you can do (work-wise) from home before getting your NMCI/email/certificates 

all setup. This is because you need the email certificate to log into Pulse Secure and get the Virtual 

Private Network (VPN) up and running. For the first week(s), be especially prompt in returning emails, 

providing signatures/information, etc. The faster you respond, the faster you can start actually working. 

- N61 team update phone calls are at 1130 Mon-Thurs on MS Teams.  

- When you get your email account set up, you will need to call the Pass and ID office number (717-

605-2276) and confirm the creation of your email account. Once confirmed, you can go to the Pass 

and ID office to get your email certificates added to your CAC card. 

- Once you complete your CAC certificate activation appointment, attempt to log into your laptop 

while still on base. If you get an error when signing in, you will need to connect to the Local Area 

Network (LAN) on base through an Ethernet cable to login to your laptop and set up the VPN for the 

first time. You only need to do this once. 

- If your NCMI account (email) has been successfully created before you have your laptop, you can 

complete the laptop pick up, certificate activation (at the Pass & ID office), and LAN Ethernet 

connection all in one trip. 

The rest of the information in this document is helpful for after you get your laptop all set up and 

running.   
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AFTER YOUR LAPTOP/VPN IS SET UP: 

TO DO: 

Connecting to the VPN: 

If possible, an Ethernet connection is greatly preferred to a wireless one. If you are able to connect via 

Ethernet, you may skip the RAS Tools connection in steps 1 and 2 below and proceed straight to the 

Pulse Secure connection starting on step 3. 

1) Right-click the RAS Tools icon in the System Icon Tray and select “Enable Hot Spot Mode”  

 

2) Once Hot Spot Mode is enabled, you will have five minutes to choose and connect to your 

(home) wireless network 

3) Once you are connected to the wireless network, select the Pulse Secure VPN Client Icon from 

the System Icon Tray 

 

4) Connect to one of the available sites to establish your BURAS connection, and choose your email 

certificate when prompted to complete the connection 

Instructions for adding the [Jacksonville] [Bremerton] Pulse Secure sites: 

1)  In the System Icon Tray, right-click on Pulse Secure icon and select "Open Pulse Secure" 

2) Within the Pulse Secure application, either click on the "+" icon, or select "File > Connections > 

Add” 

3) In the Add Connection window, type in the following information in the corresponding boxes: 

3a: Name: [NMCI Jacksonville] [NMCI Bremerton] 

3b: Server URL:  [rasjacksonville.nmci.navy.mil] [rasbremerton.nmci.navy.mil/nnpi] 
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4) Select “Add” to complete the new connection 

5) The new [NMCI Jacksonville] [NMCI Bremerton] connection should now be an available 

connection option in Pulse Secure 

 

Software Connect 

- *Run Software Connect twice a week to check for and complete RADIA pushes (software 

updates, installations, and deletions). 

- *To run Software Connect, right click on the blue box in the System Icon Tray and select 

“Software Connect.” After initiating the run, you can select “Show Console” to check on the 

progress of the push. 

- *Software Connect is blocked 0400-1600 Mon-Fri, so run it at the end of the work day or 

sometime during the weekend. 

- Run Patch Connect similarly (every once in a while) to check for pushes. 

 

Register your PKI Certificates: 

Register your certificates here: https://my.navsup.navy.mil/registration 

- Select “Civil Service Employee” 

- Organizational Affiliation: NAVSUP Weapon Systems Support 

- Duty/Position: Operations Research Analyst 

- Grade/Rank: GS-7 (or similar if you are at a different pay grade) 

- DSN Phone Number: (get from supervisor) 

- UIC/DODAAC: N00104 

- If your certificate still does not work, try completing the registration process a second time. 

 

Shared Drives: 

You will need to map to the shared J: and L: drives. 

- You are not technically required to use the letters “J” and “L” for these drives, but it is strongly 

recommended for sake of consistency when referencing file locations. 

- You will likely need to request permission to access one or more of the drives. To obtain 

permission for the drives, have a member of your team send an email to 

MECHWSS_ACTR.wss.fct@navy.mil requesting permission to the drives. Once the permission is 

granted, you should be able to map the drives successfully. 

- The J: is specific to each site and code. The path below is for N61 Mechanicsburg. If needed, 

refer to your supervisor for your J: drive path. 

https://my.navsup.navy.mil/registration
mailto:MECHWSS_ACTR.wss.fct@navy.mil


TELEWORK NEW HIRE INFORMATION  7 
 

TABLE OF CONTENTS 

 To map the [J:] [L:] drive: 

1) Open File Explorer 

2) Right-click “This PC” and select “Map network drive…” 

3) Choose [“J”] [“L”] under “Drive” 

4) Copy the corresponding drive path below into “Folder” 

5) Select “Finish” 

J: Drive – This is the shared N61 Drive. 

J: = \\naeamechfs101v.nadsusea.nads.navy.mil\CS021$\NAVSUP_PHIL_N00383_N61 

 

L: Drive – This is a shared drive for all WSS, used mostly for file sharing with Philly. 

L: = \\naeamechfs101v\cs012$\NAVSUP_PHIL_PHILMECH\CORP 

 

Entering Work Times into ERP: 

The slide pictured below came from the PowerPoint “New Hire Guide.pptx” 

Link in picture below: https://ep.erp.navy.mil/irj/portal  

 

 

- The Network numbers change every fiscal year. Contact your supervisor for the current 

timekeeping codes. 

file://///naeamechfs101v.nadsusea.nads.navy.mil/CS021$/NAVSUP_PHIL_N00383_N61
file://///naeamechfs101v/cs012$/NAVSUP_PHIL_PHILMECH/CORP
https://ep.erp.navy.mil/irj/portal
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- A full list of ERP time codes can be found in “ERP Time entry Codes.xls” 

- During telework, enter “TS” in the “Prem. no.” field. 

- *Note that time can be entered in six minute increments. This is equivalent to saying that hours 

can only be entered to one decimal place (ex: 0.5 hours is a valid entry and 0.25 hours is not a 

valid entry). 

 

WSS Alert System 

*The NAVSUP alert system will send a text/email/call in case of base closure, emergencies, and 

other base-related alerts. Information for signing up for and managing alerts can be found at 

“Guidance for AtHoc Self Service_Adding Devises.pdf” 

 

SAS (and IRAS) Server Access: 

In order to use SAS Enterprise Guide (EG), submit a SAS SAAR. This can be a particularly lengthy process 

(possibly multiple weeks). Submit this SAAR sooner rather than later. 

You will need the SAAR itself “SAS_EnterpriseGuide_SAAR.pdf” and a document containing all of the 

instructions for submission, “IRASandSASEG SAAR Guide.docx”. 

Once the SAAR is finished processing, connect to the SAS server by following the instructions in 

“Instructions New Profile SAS Enterprise Guide.docx”. 

 

Change your Address (if needed) 

1) Go to https://mypay.dfas.mil/#/civilian  

2) Select “Correspondence Address,” and then select the pencil in lower right corner to edit your 

address 

3) Once the address is changed in myPay, send an email to Payroll.WSS.fct@navy.mil requesting 

an address change for local tax purposes: 

Hello, 

 

I am sending this email to request an address change to my local taxing authority. 

 

Previous Address: [previous address] 

 

New Address: [new address] 

 

https://mypay.dfas.mil/#/civilian
mailto:Payroll.WSS.fct@navy.mil
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Vr, 

-[Name] 

 

4) You will also need to change your address at https://www.dmdc.osd.mil/milconnect. 

5) There is an additional requirement to change your address with the government travel card. If 

this applies to you, contact your supervisor for further instructions. 

 

Work Schedule Request (WSR): 

- To change your work schedule, submit a WSR to your supervisor (ex: you are working the 9’s 

schedule with an 8-hour day and a regular day off (RDO) per pay period, and you want to change 

your RDO). 

- You can submit a new WSR as often as your supervisor allows. 

- Supervisors need to submit all of the WSRs by noon on the first Wednesday of the pay period, so 

it is good practice to send your WSR to your supervisor by the end of the previous pay period. 

- When filling out a WSR, remember that the pay period start date is the Sunday before the first 

Monday of the pay period. 

There is a blank WSR on Confluence called “Empty WSR Revised Nov 2018.pdf”. 

 

Thrift Savings Plan (TSP): 

*The TSP puts money towards your retirement. As a new employee, you are automatically enrolled in a 

5% contribution to the TSP program (as of October 1, 2020). That is, 5% of your paycheck goes into a 

retirement fund. The government will match you up to 5%, so if 5% of your paycheck is $60, the 

government will give you an additional $60 towards your retirement fund. You can change your TSP 

contribution amount, but it takes a paycheck or two’s time for the change to take effect. 

TSP Information: 

https://www.tsp.gov/index.html 

How to Change your TSP Percentage: 

1) Go to the GRB Platform Website (I’m usually only able to access the GRB platform through 

Microsoft Edge, and often only after multiple attempts): 

https://www.civilianbenefits.hroc.navy.mil 

2) “Launch” the platform 

3) Select “Thrift Savings Plan” 

4) Select “Submit a TSP Transaction +” 

5) Follow the instructions on screen to complete the percentage change 

https://www.dmdc.osd.mil/milconnect
https://www.tsp.gov/index.html
https://www.civilianbenefits.hroc.navy.mil/
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6) Go back to the Thrift Savings Plan module, and you should see your percent change transaction 

listed in the lower left-hand corner under “Transactions.” The first LES dated after the 

“Effective” date for your transaction should reflect the new TSP amount. 

Note: The dollar amount of your TSP contributions is listed in your LES as the very last entry in the 

“Deductions” section. 

If you are unable to access the GRB Platform, you can change your TSP percentage by calling the civilian 

benefits hotline: 1-888-320-2917 

 

Health Benefits: 

You have a 60-day window from your start of work date to choose a health insurance plan. You also 

have a window to change after a qualifying life event (marriage, death, birth, etc.). Otherwise, you have 

to wait until the "Open Season" (early November - late December) to switch/update plans. 

 

Here is a link to the OPM Health Benefits Homepage:  

https://www.opm.gov/healthcare-insurance/healthcare/ 

 

This website has plan information, eligibility, and a list of qualifying life events and their respective 

windows for changing a plan. 

 

Submit your enrollment/changes through the GRB platform: 

1) Go to the GRB Platform Website: https://www.civilianbenefits.hroc.navy.mil 

2) “Launch” the platform 

3) Select “Health Insurance” 

4) Select “Submit a FEHB Transaction +” 

5) Follow the instructions on screen to complete the enrollment/change 

If you are unable to access the GRB Platform, you can change / sign up for a healthcare plan by calling 

the civilian benefits hotline: 1-888-320-2917 

 

Individual Development Plan (IDP) 

- Access your IDP through TWMS: https://mytwms.dc3n.navy.mil . 

- The IDP is an individual plan that maps out what developmental training you plan to accomplish 

in the fiscal year (October 1 – September 30).  

- Your supervisor will walk you through the initial creation of the IDP. You will need to populate 

your various development goals. 

https://www.opm.gov/healthcare-insurance/healthcare/
https://www.civilianbenefits.hroc.navy.mil/
https://mytwms.dc3n.navy.mil/
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- You can periodically update your IDP as you complete courses. When a course is complete, go 

into your IDP, go to the “Developmental Training” tab, select “Edit” for the course you 

completed, and fill out the “Date Completed.” 

- If you make changes to an already approved IDP, you must resubmit your IDP for re-approval. 

Your IDP must always remain in an approved status. 

- For more information, see “IDP_FAQs.docx” 

 

External Hard Drive: 

You will need to obtain a NAVSUP WSS command-issued external hard drive for backing up your 

files/data. You will need to go on base to receive the hard drive and instructions on how to operate it. 

You will need to work with the point of contact (POC) to set up a time to come in, and you will have to 

fill out some paperwork in advance. Talk to your supervisor to get the request process started. 

 

Microsoft (MS) Teams: 

- NOTE: CVR TEAMS IS GOING AWAY ON JUNE 15 

- You will get a welcome email from info@email.cvr.mil titled “Welcome to DOD’s Commercial 

Virtual Remote Environment.” This email will contain your CVR username, a temporary 

password, as well as detailed instructions for getting set up in the CVR environment. These 

instructions are also found in “End-User_Log_on_Guide_to_Microsoft_Teams.pdf”. 

- Once you set up your own password, you will use your CVR user and password to log in to MS 

Teams. 

- You can log in to MS Teams through the application on your computer, or through this website: 

teams.microsoft.com . Note: The desktop version tends have significantly less lag during visual 

MS Teams presentations, and generally is more stable connection-wise. 

- If you need to reset your CVR password, visit this site: 

https://disa.deps.mil/ext/cop/gsd/cvr/index.html#/ . The site works best in the Chrome 

browser. When prompted, use your authentication certificate to log in. 

- Your CVR welcome email should arrive within the first week of you receiving an NMCI email 

address. If you do not receive the welcome email, submit a support request here: 

https://www.navy311.navy.mil/. 

- MS Teams meetings are often recorded. If you have trouble accessing these recordings, try 

following the steps in this document: “MicrosoftStream_NCMIaccess.pdf”. 

- MS Teams is also available via your personal computer. If you are having trouble with the 

connection on your government computer, try switching to your personal computer to use MS 

Teams.  

  

mailto:info@email.cvr.mil
teams.microsoft.com
https://disa.deps.mil/ext/cop/gsd/cvr/index.html#/
https://www.navy311.navy.mil/
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TO DO (TRAINING): 

myNAVSUP Training: 

Homepage: 

https://my.navsup.navy.mil/   (select Tools > Training) 

If the above link does not work, try this link: 

https://my.navsup.navy.mil/apps/ops$mynavsup.training_list 

- This is mandatory general workforce training. Courses included topics on cyber security, 

violence prevention in the workplace, ethics, etc. 
- You will be redirected to a different website for the actual training, but when you complete a 

course, you will need to submit the completion back on the myNAVSUP page. 
- Much of this training is annual (calendar year). 
- Make sure to keep all of your certificates of completion, especially the one for the “DoD Cyber 

Awareness Challenge,” which you often need for security purposes. 

 

Enterprise Resource Planning (ERP) Training 

Homepage: 

https://www.erp.navy.mil/ 

- There is a somewhat lengthy form-filling process to get the permissions to log into the ERP page, 

but once you do have access, you will have a relatively short window (two to three weeks) to 

complete the training. 

- The information about the ERP process is quite useful in understanding the Supply Chain (SC). 

- Completed training can be found at ERP Home Page > Training > My Learner Account > Training 

Activities. 

 

DAWIA Training [Defense Acquisition University (DAU)]: 

DAU Homepage: 

https://identity.dau.edu/EmpowerIDWebIdPForms/Login/VirtualCampus 

- To begin taking DAU courses, you will first need to visit the DAU homepage (linked above) and 

select “Request an Account.” Once your account is all set up and ready to go, sign into your DAU 

account with the same link listed above. 

- There will be an option “Apply for Online Training,” where you can enroll in any online DAU 

course (excluding resident courses and virtual resident courses). 

https://my.navsup.navy.mil/
https://my.navsup.navy.mil/apps/ops$mynavsup.training_list
https://www.erp.navy.mil/
https://identity.dau.edu/EmpowerIDWebIdPForms/Login/VirtualCampus
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- If you need further assistance in creating a DAU account, see the document 

“CreateDAUStudentAccount.pdf” 

 

Online Catalog with Engineering Course Requirements: 

https://icatalog.dau.edu/onlinecatalog/CareerLvl.aspx?lvl=1&cfld=12 

 

- Over the course of the next three years, you will need to complete DAWIA training for the 

Engineer career field, levels one and two (double check your career field with your supervisor 

before you begin taking courses). Level one is all online self-paced training, and level two is a 

mixture of online courses and week-long resident courses. 

- The Online Catalog link above provides a list of the courses required for the various career field 

certifications. You will need to take all of the listed courses under “Core Certifications 

Standards” for engineering certification levels one and two. Courses lists are subject to change, 

so double check the catalog before applying for certification. 

- To be level one certified, you need to complete all of the required courses, as well work in your 

position for one year. However, you can complete level two courses before you are level one 

certified, provided you have at least completed any pre-requisites. 

- Because of COVID-19, DAU instructor-led courses are currently held virtually (at least through 

09/24/2021). The fiscal year course schedules are currently released on a six-month basis, so the 

need for virtual classes will be re-evaluated halfway through the fiscal year. Further information 

about DAU/DAWIA, including detailed step-by-step registration instructions, can be found in the 

document “Virtual Welcome Aboard DAWIA and DAU.docx”. 

Once you have completed all requirements for a DAWIA certification (including experience 

requirements), you must apply for certification. You will not be certified automatically. Apply for 

certification at: 

https://www.atrrs.army.mil/channels/navyedacm/Login/Login.aspx > Manage Career > Certification > 

Manage Certification Requests > Add Certification Request 

 

Continuous Learning (CL) 

https://www.atrrs.army.mil/channels/navyedacm/Login/Login.aspx (eDACM) > Manage Career > DON 

Continuous Learning 

You must acquire 80 Continuous Learning Points (CLP) towards your professional development every 

two years *from your work start date. Workforce members are strongly encouraged to set a goal of 

achieving 40 CLPs within each 12-month period.  

https://icatalog.dau.edu/onlinecatalog/CareerLvl.aspx?lvl=1&cfld=12
https://www.atrrs.army.mil/channels/navyedacm/Login/Login.aspx
https://www.atrrs.army.mil/channels/navyedacm/Login/Login.aspx
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- Creditable activities include DAWIA Training, and any other learning activities that “serve to 

increase performance capabilities as an acquisition professional.” This includes most “formal” 

training on the job. Check with your supervisor to see if a training activity will count towards 

your CL. 

- Your mandatory ERP and DAWIA training as a new hire will more than cover the initial 80 credit 

cycle. 

- The mandatory myNAVSUP training does NOT count towards your CL. 

- To add CL hours (note that some training is added to eDACM automatically), go to ‘Manage 

Career > DON Continuous Learning > Manage CL Hours > Add Continuous Leaning Hour 

Request’. 

 

DataCamp 

DataCamp Homepage: 

https://learn.datacamp.com/ 

- DataCamp is a website with high-quality courses to train you in SQL, R, Python, Excel, Shell, and 

more. The courses range from entry-level courses for beginners to in-depth courses for more 

experienced users. 

- DataCamp training is (in general) non-mandatory. 

- Ask your team lead which courses would be beneficial for you to take. 

- Upon completion of a course, make sure to save your certificate and send it to your supervisor 

to notify them of completion. The command tracks use of DataCamp for training funding 

purposes. There is a general DataCamp usage call sent out in an email monthly. 

 

  

https://learn.datacamp.com/
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HELPFUL INFORMATION: 

Information / Tips: 

- Base Address: 5450 Carlisle Pike, Mechanicsburg PA, 17050 

- Organization Code: (N611, N612, etc.) 

- Component / Office: 00391 / (N611, N612, etc.) 

- Job Code: 1515 

- Billet Type: Shore Duty, CONUS 

- UIC#: N00104 (this is the UIC# for NAVSUP WSS) 

 

- Fiscal Year: Oct 1 – Sept 30 

o Fiscal Q1: Oct – Dec 

o Fiscal Q2: Jan – Mar 

o Fiscal Q3: Apr – Jun 

o Fiscal Q4: Jul – Sep 

- Shared Drives: 

o C: your local computer drive 

o H: your personal “shared” drive (i.e., not local to your computer). This drive is small, but 

good for backing up important data 

o S: NAVSUP (you can ignore for the most part) 

o J: this the shared N61 Drive 

o L: this is a shared drive for all WSS, used mostly for file sharing with Philly. 

 

- “Core Hours” are 0900 – 1130 and 1300-1500. You are required to work during core hours, and 

the rest of your hours need to fall in the 0600-1800 time range (i.e. we are not supposed to 

work past 6pm). 

- Use Chrome or Internet Explorer as your browser (not Microsoft Edge unless you really need to). 

- When prompted for a certificate, if you choose one that does not work for that website, you will 

need to select “click here to create a new session,” or close the browser out and re-open it to 

reset the certificate prompt. 

- For hyperlinks sent to your email, remove the part of the URL at the beginning that says 

https://no-click.mil/? before navigating to the site. 

- You have secret clearance as a new employee, and that clearance will last for a limited period of 

time. After that time, it can be renewed on an “as needed” basis. Most ORA’s will not have need 

to renew their secret clearance. 

- You get 4 hours of annual leave and 4 hours of sick leave per pay period. 240 hours of annual 

leave will carry over at the end of the calendar year, and all of your sick leave will carry over. 

Time-off awards expire one year after being awarded. 

 

- Tip: Bookmark helpful websites as you find them. 

https://no-click.mil/?
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- Tip: Put all of the federal holidays into your calendar, so you can adjust your work schedule 

accordingly. Federal Holidays can be found here: https://www.opm.gov/policy-data-

oversight/pay-leave/federal-holidays/#url=2020 

- Tip: If your computer screen goes black or if your task bar disappears, do the following: 

 Press CTRL+ALT+DELETE 

 Select “Task Manager” 

 Selected File > Run New Task 

 Type “explorer.exe” and then “OK” 

- Tip: If your email is running slow when you type in the “To” field of an email, try the following: 

 Select File>Account Settings 

 Select “Account Settings” from the drop-down menu 

 Select “Address Books” 

 Remove all LDAP accounts (one by one) 

 

- Read the following concerning “Updated Guidance on Use of Embedded and Peripheral 

Computer Capabilities”: 

4. Personally-owned peripherals, wired or Bluetooth-enabled Use on Navy-issued 

computers. 

a. Not authorized in any classified workspaces. 

b. Authorized in telework environments and unclassified government 

workspaces, with the following exceptions: 

(1) Per reference (a), peripherals manufactured by any source that is 

designated by Navy or the Defense Information Systems Agency (DISA) as being 

prohibited are not allowed. This includes any company prohibited by law, to 

include Huawei, Zhong Xing Telecommunication Equipment (ZTE), Hikvision, 

Hytera, and Dahua. (NOTE: Users are encouraged to use the DISA APL at 

https://disa.deps.mil/org/SE6/Lists/APL/AllItems.aspx to inform their personal 

peripheral procurements). 

(2) Per reference (a), storage devices (e.g. Universal Serial Bus (USB) 

memory sticks, hard drives, digital cameras, etc.) are prohibited. 

https://www.opm.gov/policy-data-oversight/pay-leave/federal-holidays/#url=2020
https://www.opm.gov/policy-data-oversight/pay-leave/federal-holidays/#url=2020
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(3) Per reference (a), external monitors are prohibited, when using USB 

connections. 

(a) Per reference (a), external monitors using VGA, DVI, HDMI, or 

Display Port connections, provided they do not have any memory storage 

capabilities, are authorized. 

(4) Per reference (f), any personally-owned device that provides print 

functions, including multi-function devices, are prohibited. 

 

Links (With Descriptions): 

The below websites might be helpful to bookmark: 

DCPDS Portal: 

https://compo.dcpds.cpms.osd.mil/ 

- MyBiz – Personnel, Pay, Leave, and Insurance Information. (sometimes a pay-period or two out-

of-date). 

- There is a “Civilian Career Report” option that gives a nice summary of information about you as 

an employee (identification information, pay information, etc.). 

- MyPerformance – DPMAPS assessment system (see below). 

DPMAPS: 

- This is the performance assessment system. Your overall job performance will be graded on 

a 1/3/5 grading system, with monetary awards given out for high scores. 

- You will create a performance plan as a new employee with your supervisor. 

- About halfway through the assessment cycle, you will provide input about your work 

performance. It is helpful to keep track of the things you accomplish in your position as you 

accomplish them. That way when it comes time to provide input, you do not have to track 

down and/or try to remember past accomplishments. 

- The current Assessment Cycle is Apr 1, 2020 to March 30, 2021. 

myPay 

https://mypay.dfas.mil/#/civilian 

- *This website has pay-related information, including your Leave and Earnings Statement (LES), 

Tax Statements, and more. You can also make changes to your federal/state withholding (W4), 

change your correspondence address, and turn off hard copy LES statement delivery if you wish 

to do so. 

eOPF 

https://eopf.opm.gov/navy/ 

https://compo.dcpds.cpms.osd.mil/
https://mypay.dfas.mil/#/civilian
https://eopf.opm.gov/navy/


TELEWORK NEW HIRE INFORMATION  18 
 

TABLE OF CONTENTS 

- This is your electronic Official Personnel Folder – it contains forms that you have submitted 

by/for you (TSP changes, award forms, etc.). 

DoD Safe: 

https://safe.apps.mil/ 

- This a secure way of sending files, normally used when files are too big for an email attachment, 

and/or if you do not want to put it in one of the shared drives where everyone has access. 

GRB Platform: 

https://www.civilianbenefits.hroc.navy.mil/ 

- This platform is where you can view information about your Health Insurance, Life Insurance, 

Social Security, Thrift Savings Plan, and more. It is also where you submit changes for the above-

mentioned topics (it is where you submit a TSP percentage change, for example). 

Confluence 

- Confluence is a collaborative space for your team, where you can create/use/share files, wikis, 

tasks/task trackers, calendars, blogs, and more. 

- Here is a link to the NAVSUP WSS N6 Home page: 

https://wiki.navsup.navy.mil/display/N6C/NAVSUP+WSS+N6+Home 

- A link to your team space can be found at: NAVSUP WSS N6 Home page > Site Map > NAVSUP 

WSS N6 TEAMS. You can bookmark your team space once you find it. 

- Contact LCDR Tony Urech anthony.c.urech@navy.mil or Daniel Diethrich 

daniel.diethrich@navy.mil with Confluence questions. 

Total Workforce Management Services (TWMS): 

https://mytwms.dc3n.navy.mil 

- TWMS is often finicky in terms of actually getting into the website. Sometimes you have to 

submit the certificate twice; some browsers work some days and not others. 

- Houses much of the myNAVSUP training. 

- Houses your Individual Development Plan (IDP). 

eDACM: 

https://www.atrrs.army.mil/channels/navyedacm/Login/Login.aspx 

- eDACM is “The DON’s Secure System for Managing your Career in Acquisition” 

- Document your Continuous Learning (CL) Hours (see section on Continuous Learning) 

- Apply for DAU instructor-led training (see section on DAWIA training). 

- Apply for various acquisition-related programs/certifications/events. 

Navy 311 Help Desk: 

https://safe.apps.mil/
https://www.civilianbenefits.hroc.navy.mil/my.policy
https://wiki.navsup.navy.mil/display/N6C/NAVSUP+WSS+N6+Home
mailto:anthony.c.urech@navy.mil
mailto:daniel.diethrich@navy.mil
https://mytwms.dc3n.navy.mil/
https://www.atrrs.army.mil/channels/navyedacm/Login/Login.aspx
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https://www.navy311.navy.mil/home 

- This website is where you can submit support request for any sort of account/CAC/technical 

issues you may be having. 

- To submit a request, or to check the status of a previous request, select “CAC Users” under 

“Submit a Support Request” on the website’s home page. 

Office 365 Online Portal [Outlook Web Access (OWA)]: 

On an NMCI computer: https://portal.apps.mil 

OWA outside of NCMI network: https://webmail.cloud.navy.mil  (need to contact supervisor for 

permission/protocol for accessing Outlook on a non-NMCI machine) 

- This link is for accessing your Outlook email online, rather than through the Outlook app. 

- Use Internet Explorer as your browser. 

- Note: OWA uses the CAC card for signing in, so you do not have a ‘password’ for Outlook. 

 

Acronyms: 

BBD  Basic Business Drumbeat 

BSC  Business Systems Center 

DLA  Defense Logistics Agency 

ERP  Enterprise Resource Planning 

FYSA  For Your Situational Awareness 

NAVSUP Naval Supply Systems Command 

NIIN  National Item Identification Number 

ORA  Operations Research Analyst 

POC  Point of Contact 

RDO  Regular Day Off 

SAAR  System Authorization Access Request 

SC  Supply Chain 

VR, Vr, V/R Very Respectfully 

WIOM  Wholesale Inventory Optimization Model 

WSS  Weapons System Support 

https://www.navy311.navy.mil/home
https://portal.apps.mil/
https://webmail.cloud.navy.mil/
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There is a full Acronym Guide called “Weapon Systems Support (WSS) Acronym Desk Guide.pdf”. 

 

Information Resources: 

Contact List 

*See the document “N6 Contact List.pdf” for a list of phone numbers of leaders in N6. Also located at 

“(NAVSUP_PHIL_PHILMECH) L:/N6/Contact Information”. 

 

*Equal Opportunity - Reporting 

NAVSUP has a zero tolerance rule for harassment and unlawful discrimination against persons or groups 

based on race, color, religion, sex (including gender identity), creed, ethnicity, national origin, or sexual 

orientation. 

If you witness harassment that meets any of the above criteria (against yourself or against others) it is 

your duty to report this behavior. For details on who to report to, see “Stand-down to Extremism Report 

Card.pdf”. 

If you are a victim of sexual harassment: 

Sexual Assault Victim Assistance 24/7 Hotline: 267-693-9104 

NSA MECH Sexual Assault Prevention Response Victim Advocate: 717-363-0060 

 

NAVSUP Home Webpage 

https://www.navsup.navy.mil/public/navsup/home/ 

This is the public NAVSUP website, and has some helpful big-picture information about NAVSUP. 

 

*NAVSUP WSS Training 

 

https://my.navsup.navy.mil/webcenter/portal/navsupwss_maritime_training?_adf.ctrl-

state=oq9byozpi_1&_afrLoop=3874897420885850#!%40%40%3F_afrLoop%3D3874897420885850%26_

adf.ctrl-state%3Doq9byozpi_5 

 

This website contains a large number of briefs that give overview presentations of all of the functional 

areas and job roles within WSS. There are three intro to WSS briefs, WSS general training materials, and 

more specified training broken down by code. 

https://www.navsup.navy.mil/public/navsup/home/
https://my.navsup.navy.mil/webcenter/portal/navsupwss_maritime_training?_adf.ctrl-state=oq9byozpi_1&_afrLoop=3874897420885850#!%40%40%3F_afrLoop%3D3874897420885850%26_adf.ctrl-state%3Doq9byozpi_5
https://my.navsup.navy.mil/webcenter/portal/navsupwss_maritime_training?_adf.ctrl-state=oq9byozpi_1&_afrLoop=3874897420885850#!%40%40%3F_afrLoop%3D3874897420885850%26_adf.ctrl-state%3Doq9byozpi_5
https://my.navsup.navy.mil/webcenter/portal/navsupwss_maritime_training?_adf.ctrl-state=oq9byozpi_1&_afrLoop=3874897420885850#!%40%40%3F_afrLoop%3D3874897420885850%26_adf.ctrl-state%3Doq9byozpi_5
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https://my.navsup.navy.mil/webcenter/portal/navsupwss_maritime_training/Supply+Planner?_afrLoo=

51247172504796070&_adf.ctrl-

state=zusdavdzb_95#!%40%40%3F_afrLoop%3D51247172504796070%26_adf.ctrl-

state%3Dzusdavdzb_99 

 

This website contains more training, but it is directed at planners. ORA work directly impacts the 

planners job, so it is important to know the basics of what they do. Two helpful presentations are 

“Supply Planner Desk Guide.pdf” and “SPL101 Maritime Supply Planner Overview.pptx”, both of which 

have helpful overview information.  

 

New Hire Guide 

There is a very informative PowerPoint called “New Hire Guide.pptx”. This presentation assumes that 

the new hire is on-boarded on base. 

 

N61 Training 

Every Thursday, someone from N61 gives an internal training presentation on some basic concept of 

Operations Research in NAVSUP WSS. These informative PowerPoints for the presentations can be 

found at: 

J:\$N61share\Training 

These presentations are recorded in MS Teams, and the videos are posted to the Training folder listed 

above. 

 

*NAVSUP WSS Culture Team Briefs 

You will likely be required to attend a series of presentations for a “New Employee Briefings”, hosted by 

the NAVSUP WSS Culture Team. To access these briefs after/before, go to  

[MS Teams > Teams > Join or create a team > search for “NAVSUP WSS Culture Team” > Join Team].  

Once you have joined the teams, go to  

[NAVSUP WSS Culture Team > General > Files]. 

The files include briefings on OPSEC, Ethics, Payroll, and more.  

 

Team Lead Briefs 

https://my.navsup.navy.mil/webcenter/portal/navsupwss_maritime_training/Supply+Planner?_afrLoo=51247172504796070&_adf.ctrl-state=zusdavdzb_95#!%40%40%3F_afrLoop%3D51247172504796070%26_adf.ctrl-state%3Dzusdavdzb_99
https://my.navsup.navy.mil/webcenter/portal/navsupwss_maritime_training/Supply+Planner?_afrLoo=51247172504796070&_adf.ctrl-state=zusdavdzb_95#!%40%40%3F_afrLoop%3D51247172504796070%26_adf.ctrl-state%3Dzusdavdzb_99
https://my.navsup.navy.mil/webcenter/portal/navsupwss_maritime_training/Supply+Planner?_afrLoo=51247172504796070&_adf.ctrl-state=zusdavdzb_95#!%40%40%3F_afrLoop%3D51247172504796070%26_adf.ctrl-state%3Dzusdavdzb_99
https://my.navsup.navy.mil/webcenter/portal/navsupwss_maritime_training/Supply+Planner?_afrLoo=51247172504796070&_adf.ctrl-state=zusdavdzb_95#!%40%40%3F_afrLoop%3D51247172504796070%26_adf.ctrl-state%3Dzusdavdzb_99
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The team leads for N61 gave “Intro to Team Lead” briefs in early 2021. Those that used slides for their 

briefs have placed their slides at: J:\$N61share\NewEmployeeInfo\TeamLead_Intro 

 

WSS Organizational Chart 

There are four WSS organizational charts: “NAVSUPWSS_ORG_202101.pdf”, “NAVSUP WSS Mech Org 

Chart Oct 2020.pdf”, “NAVSUP WSS Phil Org Chart Oct 2020.pdf”, “NAVSUP WSS International Programs 

Org Chart Oct 2020.pdf”. 

 

System Authorization Access Request (SAAR) 

SAARs are used to request access for a variety of different systems. Use “Empty_SAAR.pdf” if you need a 

blank request form. 

 

Phone Numbers: 

Sexual Assault Victim Assistance 24/7 Hotline 

267-693-9104 

NSA MECH Sexual Assault Prevention Response Victim Advocate 

717-363-0060 

Suicide Prevention 24-hour Hotline 

1-800-273-TALK (8255) 

Non-Emergency Dispatch 

717-605-6670 

Weather Hotline 

717-605-2000 

NSA Command Duty Officer 

717-439-2899 

NMCI Service Desk 

1-866-THE-NMCI (843-6624) 

Civilian Benefits Hotline:  
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1-888-320-2917 

 

 

All files highlighted in yellow are in the Confluence N6 Homepage. Files are Located at: 

- https://wiki.navsup.navy.mil/display/N6C/NAVSUP+WSS+N6+Home [NAVSUP WSS N6 Home 

Page > Site Map > N6 File > TELEWORK New Hire Files] 

The files are also located on the shared J: drive at J:\$N61share\NewEmployeeInfo\Files 

 

*Information Revised/Added – 04/07/2021  

https://wiki.navsup.navy.mil/display/N6C/NAVSUP+WSS+N6+Home

